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1 Introduction 

SafeFit is part of the SafeSuite family of products, which aid in the development of projects 

following common industry’s safety standards. 

SafeFit focuses on the reliability prediction of electronic equipment. Reliability of a component 

is summarized in a so-called FIT value (Failure-in-time), which is calculated according to several 

rules from a chosen standard. 

SafeFit currently supports these reliability prediction standards: 

- IEC 62380 (International Electrotechnical Commission) 

- MIL 217F (USA Military) 

1.1 Features 

- Support for IEC62380, MIL217F. 

- Import/Export of data in CSV for interoperability with external programs. 

- Save/Load data in custom format enabling app-specific features. 

- Grid-based, single-view interface. 

- Fully keyboard and mouse enabled. Copy/Paste support to/from clipboard.  
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2 Usage 

2.1 Application parts 

 

1. Menu 

a. File > (New > (IEC-62380 | MIL-217F) | Load | Save | Import | Export | Exit) 

b. Help > (About | License) 

2. Standard’s global parameters 

3. General view grid 

4. Display component selector 

5. Detail view grid 

The above screenshot shows the initial state of the main window, which by default uses IEC-

62380. 

The global parameters section is standard-specific. Further details are discussed in their own 

section. There is a “Compute” button for quick batch recalculation when global parameters are 

changed. Per component re-calculation however, is also done after any row editing. 

The general view is intended for quick review of current loaded components. Supports sorting of 

its columns for easier navigation. 
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The detail view is where all components are added/removed, and its details edited. The current 

component type in display is selected through a combo box. Component types depend on the 

standard too, but are quite similar nonetheless. The grid supports sorting and column reordering. 

2.2 Licensing 

The application has three licensing states: 

- Unlicensed/invalid/expired license: in other words, no license. 

- Demo license: expires after a time interval (14 days). 

- Full license: lifetime license. 

The “No license” state blocks the Save, Import, Export features. Loading is still possible for demo 

purposes, but severely limits the application’s usability. 

A license can be requested with the “Help > License” dialog. The dialog shows brief instructions, 

which are hereby developed: 

1. Select the desired license type: either “Demo” or “Full”. The full license requires an order 

ID. 

2. Click the “Generate” button, which creates several files and opens their location on disk. 

3. Send the file named “LicenseRequest.dat” to the e-mail address support@safetwice.com 

4. The e-mail will be replied (if all is correct) with a file “License.dat”. Copy this file to the 

same place where the request is located. 

5. Close and reopen the program for the license to get detected.  

 

 

 

 

 

 

 

NOTICE: the license folder can be quickly found with the “Find” button in the “License” dialog. 
It should be in “C:\Users\<USER>\AppData\Local\SafeTwice\SafeFit\License”. 

NOTICE: to be able to regenerate the license request, if required, delete from disk the files 
“LicenseRequest.dat” and “PrivateKey”. 

NOTICE: the “.dat” extension is important. Add it in case it is missing in the “LicenseRequest” 
or “License” files. Otherwise the application will not properly recognize the license. 

NOTICE: a license is only valid for the computer it was generated in.the “.dat” extension is 
important. Add it in case it is missing in the  

mailto:support@safetwice.com
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2.3 Standard selection 

The currently used standard can be selected through the “File > New” menu. This clears current 

data and initializes the workspace for such standard. 

Additionally, when loading a project file, the appropriate standard for the project is loaded 

seamlessly. 

The current standard is always indicated in the app’s title bar. 

2.4 Detail view workflow 

There are four common columns used by all components: 

- Designator 

- FIT Def 

- FIT Comp 

- Description 

The designator value depends on the selected component and the standard. Valid values are 

shown in this document. However, they follow the rule: “<name><number>[<subitem>]” (R1, C1, 

U1A, …). 

- Name: standard designator, e.g. R – Resistor, C – Capacitor, etc. 

- Number: any positive number. 

- Subitem: optional upper-case letters for further categorization. 

- “FIT Def” stands for defined FIT, which is an independent cell included for 

reference/comparison purposes. 

- “FIT Comp” stands for computed FIT. These cells are not directly editable, but change 

according to the calculated FIT for the current input parameters. 

In general, a cell with invalid data, e.g. negative value for a positive only decimal value, is marked 

with a red border. 

The application, according to the standard in use, groups components into single or groups of 

several electronic components, e.g. resistors or optoelectronics.  
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The “Type” column is somewhat special and indicates the actual component type in groups of 

components, or component subgroup. This is very intuitive in general. 

Some columns may appear grayed out, meaning that its value is not necessary for the calculation 

of the FIT for the selected type. 

When all required values are filled in, the FIT is automatically computed. This is also the case 

when editing an existing value. However, global parameter changes require batch recomputation 

with the “Compute” button. 

The grid supports copy/paste both between itself and external programs, since it uses the 

system’s clipboard. Hence, data in the clipboard with tabular format (e.g. Excel) can be easily 

pasted into the program. Either row, column or rectangle selection is supported. Pasting however, 

will only work when the input data and the target cells have the same data types. The user can 

move data to/from Excel this way, for instance, and experiment with the feature. 

 

 

 

 

 

 

 

2.5 Import/export 

The application can read and write CSV files. This enables interoperability with external programs 

like Excel for instance. However, this becomes more interesting with the fact that PCB board 

designers like “Altium Designer” can export the BOM (bill of materials) in CSV with extra, 

configurable parameters per component. Thanks to this, once the external program is correctly 

configured, the calculation of the FIT of all components in the BOM is quick and error-free. 

QUICK TIPS: 

- Cells can be empty. Press “Backspace” key with a cell selected in order to clear it. 

- Rows are added filling in the cells of the last row and pressing “Enter” key. 

- A single row can be deleted fully selecting by clicking on the row header and pressing the 

“Del” key. 

- All rows of the displayed component can be deleted with “Right Click” > “Delete Rows”. 

- All cells of a column can be cleared with “Right Click” > “Clear Column”. 

- Similarly, copy and paste operations are available through the context menu (“Right 

Click”) as well as with the system’s usual “Ctrl-C”, “Ctrl-V” key shortcuts. 
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The CSV format requires a minimal compulsory header of just one column: “Designator”. All other 

columns are optional. Values of optional columns are also optional, i.e. empty values are allowed. 

There are columns of various types: 

- String: accepts any value, since CSV data is text by definition. 

- Decimal: integral or decimal values, in exponential notation too. 

- Enumerable (list): accepts either an integral value in the range of index values (zero-

based), or the exact string value of one of the items in the list. 

The type of a column is predefined and can be reviewed in the appendix of a given standard (in 

this document). Watch out for units in numeric values. 

Note: when importing CSV data, make sure that the app’s selected standard matches that of the 

CSV, or else there will be import errors (likely interrupting the import process). 

2.5.1 Import dialog 

 

A CSV file is selected by clicking “Browse” and searching for it with the usual system’s file 

explorer. 

The file is automatically parsed when browsed. If a path exists in the textbox and the user wants 

to reload it, it can be done by clicking “Parse”. 

File contents can be imported completely (“Complete” option) or in parts (“Fixed” option plus 

individual component checkbox selection). 

Imported data components type and number can be reviewed easily. 
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Imported data can either be appended (“Overwrite” unchecked) to existing data or it can replace 

existing data (“Overwrite” checked). 

Final importing into the current project dataset is done by clicking “Import”. 

2.5.2 Export dialog 

 

The current data set can be exported completely (“Complete” option) or in parts (other options). 

Included column headers depend on the selected option. “Complete” includes all columns. “Fixed” 

includes only those selected, independently of having existing items or not. “Current” exports 

current selected component in the detail view. “Compact” exports all with existing items. 

Select “Existing Only” to export only selected components with non-zero items. 

Click “Export” to accept and finish the export operation. 

2.6 Save/load 

The project file has “.sfit” extension. This file enables app-specific functionality that CSV 

import/export features cannot provide. Among other features, it stores the current standard in 

use and its global parameters. 

Save/load of project files is done through the “File” menu. 
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3 IEC 62380 

Global parameters for IEC-62380 are called “Mission Profile”. These include several thermal 

phases (each characterized by an Ambient Temperature and a time ratio Tau) and several thermal 

cycles (each characterized by a temperature Delta, a Number of cycles, and a Dormant parameter). 

Standard mission profiles from the IEC 62380 TR can be easily selected through the “cog” button 

(mission profile settings). After any change, the “Compute” button must be clicked for a complete 

recalculation. 

The “Delta Temperature” parameter of the mission profile can be overridden in some components 

of the standard that include an auto-heating term in their FIT formulae. The appropriate column 

is “Delta T” (in Celsius). 

 

 

 

 

 

For a complete list of components, designators, parameters and values, see the appropriate 

standard reference for SafeFit. 

4 MIL 217F 

This standard’s global parameters are only “Ambient Temperature” and “Environment” type. 

Many components have “Type” and “Style” (or subtype) columns. Parameter values that are input 

via a list require a component’s type to be committed before allowing further input. Make sure 

to press enter (commit) after creation of a component with its type before filling in the rest of 

the parameters. This also sets up the appropriate parameter vs. type sensitivities. 

In general, “Type”, “Style” and “Quality” columns are shared among most of the components of 

the standard. 

NOTICE: “Delta T” override functionality can be used to apply a complex thermal scheme to 
the calculated system. When empirical auto-heatings are not available, SafeFIT will use 
calculated predictions based on component characteristics and electrical operating 
conditions. 

NOTICE: “Dormant” check box can be used to define a thermal cycle for a dormant or off state 
of the system (no auto-heating considered). Please check IEC 62380 TR for further information. 
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The profile’s ambient temperature is overridable in many components using the “Tamb” column. 

 

 

 

Several components with an auto-heating factor provide two ways to input the auto-heating 

required parameters: either use “Power” and “Rth”, or “Tj” (junction temperature – has 

precedence). 

 

 

 

For a complete list of components, designators, parameters and values, see the appropriate 

standard reference for SafeFit. 

5 IEC 61709 

This standard is quite different from the others, as the idea behind it is to translate FIT values 

from a set of operating conditions to other ones. The approach taken is more experimental, which 

can lead to more realistic results if the reference data is taken from conditions similar to those 

seen by the final device. It is also less costly to work with, as it is simpler (has less parameters). 

This implies that some input reference or experimental data is required for this standard to be 

applicable. Ideally, experimental data for a similar device or conditions is best. Otherwise, the 

standard by Siemens “SN29500” provides reference data which is good enough. As a last resort, 

reference FIT data can be computed by using any of the more theoretical standards implemented 

in SafeFit. Moreover, the app comes with SN29500 data that can be used for convenience. 

The standard has the concept of reference conditions. In SafeFit, the concept of experimental and 

operational data is introduced. Experimental data is field data, i.e. data that is obtained by 

collecting reliability data from components of devices in the field. Operational data is FIT data for 

a final device for which reliability is being assessed, under a specific set of operation conditions. 

NOTICE: “Tamb” override functionality can be used to apply a complex thermal scheme to the 
calculated system. When empirical temperature measures are not available, SafeFIT will use 
calculated predictions based on component characteristics and electrical operating 
conditions. 

NOTICE: When “Tj” is provided, SafeFit will use it to calculate component’s self-heating.  When 
it is not provided, SafeFit will do calculations based on thermal resistance (Rth) and electrical 
power (Power). 
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The panel is designed with two workflows in mind: 

- Introduce experimental FIT data and compute the reference FIT data. 

- Load reference FIT data and use that to compute operational FIT data. 

Experimental or operational data is displayed by changing the combo box selection. 

The general view data grid shows all components in the system (operational) for convenience. 

The “Compute” button is used to refresh internal data and recalculate FIT’s. For performance 

reasons, some changes will only be propagated when pressing this button. In many cases 

however, changes will take effect immediately. 

There is a settings button (cog icon) that is explained in its own subsection. 

Import/export functionality works similarly to what has been explained before. The difference in 

this standard is that both experimental and operational data can be imported/exported 

independently. The input/output CSV files have the same structure for both experimental and 

operational data. 

Something to note is that experimental data to be imported needs to have appropriate 

designators, as this is the only way to tell which type of reference component is contained in 

each row. Exported experimental data will have such designators already. Not all columns are 

exported, only those of interest. Similarly, not all columns are imported, so there can be user-

defined columns in the CSV.  

The import process will only stop when validation errors are found, which typically will happen 

when a type-related field has a typo. Error dialogs should give enough info to find the issue. 

For a complete list of components, designators, parameters and values, see the appropriate 

standard’s reference for SafeFit. 
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5.1 Experimental data 

 

The reference/experimental data is managed via this data grid. This data is later used in the 

computation of operational FIT’s. There is no limit to the number of reference components 

available in the data grid. These do not have the concept of a designator since an operational 

component and its reference component counterpart are linked by the type. 

There is a set of columns that is common among components. These are: 

- Key: this can be any text. The idea is to be used as a category. This is a non-unique field. 

This is useful when there is more than one reference component of the same type (and 

subtype if any), in which case the “Key” field helps in distinguishing between them. This 

field is later referenced in the operational data grid.  

- Description: optional brief description of the component or its function, for instance. 

- Type: type of the component, as stated in the standard. Some names have been shortened 

for convenience. See the reference for details. 

- FIT Exp: the experimental FIT value. Units are 1E-9 h-1. 

- FIT Ref Comp: computed reference FIT. Only updated when all required data is filled in. 

- FIT Ref Def: defined reference FIT. If present, this value overrides “Fit Ref Comp” as the 

reference FIT to be used in operational data computations. 

Apart from these, more columns can appear depending on the selected component. These 

basically fall into two categories: 
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- Subtype columns: there are two kinds of components in the standard, when it comes to 

types: those with simple types and those with complex types. A simple-type component 

has no subtypes, whereas a complex-type component has at least one subtype, and its 

type is only fully defined when the type and all subtypes are selected. 

- Parameter columns: these are the operation temperature, voltage, current, rated voltage, 

rated current and so on. In other words, these define the operation conditions for which 

the experimental FIT’s where collected. 

5.2 Operational data 

 

The operational data is managed via this data grid. These are really the components present in 

the device for which FIT values need to be computed. 

There is a set of columns that is common among components. These are: 

- Profile (leftmost): this is a button column. The button will only be shown when the profile 

type is “Complex”. When pressing this, the complex profile row detail will open/close. 

- Designator: the name of the component. No validation is done on this field, but following 

the convention is recommended. 

- Description: optional brief description of the component or its function, for instance. 

- FIT: final computed FIT result. 

- Type: type of the component, as stated in the standard. 
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- Key: reference to the “Key” field in the experimental data. Here will be listed the key of 

each experimental component of the exact same type. If only one exists, it will be auto-

selected after the operational component is fully type-defined (for convenience). 

- FIT Ref Comp: FIT value of the associated reference component. 

- FIT Ref Def: if a value is present here, it will override the value of the field “Fit Ref Comp”. 

This allows overriding the reference FIT per component if necessary. 

- Profile: type of mission profile for the component. There are 3 types of profiles: None, 

Dormant, or Complex. See details below. 

- Dormant Ratio: ratio of time when the component is in dormant state. This field is only 

enabled when the “Dormancy” profile type is selected. 

- Dormant Factor: FIT reduction factor when the component is in dormant state. If this field 

has a value, it will override the general setting. 

- Time Ratio: (profile data grid only) ratio of the operation time when this profile scenario 

is active. 

Apart from these, more columns can appear depending on the selected component, just as 

described before. 

In this standard, the mission profile is not a general setting. Instead, each component can have 

its own mission profile that depends on its type and the specific conditions it is subject to. SafeFit 

accounts for three different profile types: 

- None: no mission profile. 

- Dormancy: the component is passive during a certain ratio of its operation time, having 

reduced stress (FIT) during that period. The final FIT will be: 
𝐹𝐼𝑇𝐷𝑜𝑟𝑚𝑎𝑛𝑐𝑦 = 𝐹𝐼𝑇[𝑟𝑎𝑡𝑖𝑜 + 𝑓𝑎𝑐𝑡𝑜𝑟(1 − 𝑟𝑎𝑡𝑖𝑜)] 

- Complex: the component can be in different operation states during part of its operation 

time. In this mode, dormancy can be activated optionally, in which case it will use the first 

item in the profile data grid as the full stress conditions. If activated, it will automatically 

take the remaining time ratio as the dormant period. Bear in mind that the sum of time 

ratios is expected to be between 0 and 1. There is no validation on this, but exceeding this 

range will result in incorrect FIT values. The final FIT will be: 

𝐹𝐼𝑇𝐶𝑜𝑚𝑝𝑙𝑒𝑥 =∑𝑡𝑖 · 𝐹𝐼𝑇𝑖

𝑁

𝑖=0

+ 𝑡𝑑 · 𝜌 · 𝐹𝐼𝑇0 

Where: 
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𝑡𝑑 Dormancy time fraction 

𝑡0 Full stress time fraction 

𝜌  Dormancy FIT reduction factor 

∑𝑡𝑖

𝑁

𝑖=0

+ 𝑡𝑑 = 1 

In many cases, using the dormancy profile may be enough. However, if more precision is required, 

the complex profile can be selected independently per component. Not being an all-or-nothing 

option is convenient so that the data input effort is kept constant. 

 

5.3 Settings 

 

There is a general dormant factor that can be edited in this dialog. This value will apply to all 

components where dormancy is enabled, only if the dormant factor column for that row is empty, 

since this field has priority. 

The standard has the concept of an environmental factor. This is applied on top of all other factors 

(temperature, voltage, etc.). There are only three cases, accounting for increasingly harsh 

environmental conditions. In the end, the factors are 1, 2 or 4 (multiplicative). 

In general, the factor is most useful for operational data computation. However, in case it needs 

to be applied to experimental data computation, there is a checkbox to enable that. Bear in mind 

that this is a general setting. If experimental data were to come from a device with different 

environmental conditions, then the process would have to be split in two steps: first computing 

the reference FIT’s and exporting that (or copying to the “Fit Ref Def” column) so as to somehow 

freeze the data, and then setting the appropriate environmental factor for the operational data 

and using the frozen reference data. 


